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About this document 
This guide is designed to assist the user in becoming quickly familiar with the capabilities of PIPER, its 
interface and how the program is used.  
 
It has been produced to the recommendations of British Standard BS7649 – Guide to the design and preparation 
of documentation for users of application software. 

Trademarks 
All trademarks acknowledged. 
. 

Associated PEL Support Services Documents 
PIPER Reference Guide: This document describes the technical basis of the fluid flow calculations 

performed within PIPER. 

PIPER System Guide: This document describes the system specific aspects of PIPER that fall outside 
the scope of the PIPER Reference and User documents. 

Contacting PEL Support Services 
This program is developed, maintained and supported by PEL Support Services, ABB. We run a Hotline 
telephone and email service to answer any queries about PIPER. 
 
Please let us have any suggestions on how you feel we could improve PIPER. You can contact us by any of the 
following routes: 
 
By Telephone: ++44 (0)1925 74 1126 

By Fax: ++44 (0)1925 74 1265 

By E-mail: pel.support@gb.abb.com 

By Post: PEL Support Services 
ABB Ltd. 
Daresbury Park 
Daresbury 
Warrington 
Cheshire 
WA4 4BT 
United Kingdom 

 
 
 
 
 
 
 
 

Owner: M. G. Pass, ABB. 
Approved By: M. G. Pass, ABB. 
Document Version / Issue Date: Version 1.4 / 24 October 2005 
Last Amended Date: 24 October 2005 
Last Amended By: G. Langford, ABB. 

 ABB 2001 
No part of this publication may be reproduced, transmitted, transcribed or stored in any retrieval system or 
translated into any human or computer language without the prior written permission of ABB. 
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Change history 
This table records the changes made to each new revision of this document. 
 
Changes to approved issues are indicated by a double revision bar on the outer margin next to the text. This is 
an example. 
 
Revision Date Description of change 
1.0 20 April 2000 First Approved Issue 
1.1 23 Oct. 2000 Second Approved Issue comprising the following: 
 Amended: Section 2.1 – Title, introduction text and Figure 1 updated.
  Amended: Section 2.6.2.3 – Text and figure updated for Valves Tab. 
  Amended: Section 2.7 – PIPER Toolbar format revised. 
1.2 21 March 2001 Third Approved Issue (ABB logo added). 
1.3 10 October 2002 Fourth Approved Issue comprising the following: 
 Amended: Industrial IT logo & paragraph added, “Eutech” removed, 

Front page modified. 
1.4                   |  24 October 2005 Amended Removed Industrial IT logo & paragraph. 
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1. PIPER User Guide 

1.1. Introduction 
PIPER is used to calculate the pressure change or flow of a liquid, two-phase mixture or gas 
through an unbranched closed piping system. 
 
The program makes allowance for heat transfer through the pipe wall and change of phase at any 
point in the system. Variations of phase compositions and physical properties with temperature 
and pressure are accounted for during the calculations. 
 
PIPER will not model a solid phase or a two liquid phase system. 
 
The inlet stream to the system is defined by the inlet pressure, mass quality or temperature and 
overall stream composition which are supplied by the user.  

Note. The mass quality is defined as the mass fraction of vapour in the stream. 

PIPER has two modes of operation: 
 

Specify flowrate and inlet pressure Pressure drop is calculated. 
 
If choked, the maximum non-choked flowrate is 
calculated. 

  
Specify inlet and exit pressures Flow rate is calculated. 

 
If choked, all pressure discontinuities are modelled. 

1.1.1. PIPER System Specification 
Although the piping system in PIPER must be a single unbranched pipe, this pipe can be made up 
of the following: 
 
•  Straights 
•  Bends 
•  Contractions 
•  Enlargements 
•  Gate Valves 
•  Globe Valves 
•  Orifices. 
 
The definition of the bends and straights elements allows for full description of the three 
dimensional geometry of the piping system. 
 
In addition to defining the piping system, PIPER requires a detailed description of the variation of 
the fluid physical with the temperature and pressure. This is achieved by specifying a physical 
properties (.PPB) file produced using a product such as PhysPack. This allows the physical 
properties to be calculated as a continuous function of temperature and pressure throughout the 
system. 
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1.1.2. PIPER Calculation Assumptions 
Equilibrium is assumed between phases, that is, no allowance is made for heat/mass transfer 
limitations within a phase, between phases or between the fluid and its surrounding. 
 
A homogenous model for the two phase flow is implemented. This means that no allowance is 
made for slip between phases. 

Note. PIPER uses strict IS units for its input and results. However, like all PEL programs, it can 
perform in-cell units conversion. See Appendix B for more information about this feature. 

1.2. About this Guide 
This guide is designed to assist the user in becoming quickly familiar with the capabilities of 
PIPER, its interface and how the program is used. 
 
The chapters are organised as follows: 
 
Chapter 1 − An introduction to PIPER. 

Chapter 2 − Details the PIPER user interface. 

Chapter 3 − A tutorial to guide the user through a typical PIPER session emphasising 
the commonly used features. It is recommended that the user should read 
this chapter while running the program. 

Appendix A − Detailed instructions for creating a physical properties .PPB data file. 

Appendix B − Describes the in-cell units conversion facility. 

Appendix C − Choosing a Fluid Flow Program. 

Appendix D − Troubleshooting. 
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2. The PIPER User Interface 
The PIPER user interface displays tabs that allow easy definition of the systems being modelled. It 
also offers many useful features including automatic unit conversion and a calculator. 
 
On-line documentation is available within the program. 

2.1. The PIPER start up screen 
The PIPER start up screen consists of the following elements: 
 

Menu Bar Displays the menu options that are available. 

Toolbar Buttons Descriptive text appears automatically as the cursor is held over the buttons. 

Tabs The start up screen also displays four tabs. These are: 

 Conditions Allows the conditions for the calculation to be 
entered. 

 Physical Properties Allows a Physical Property (.PPB) data file to be 
input into PIPER. 

 Pipe Editor Used to add the fittings to the pipe. 

 Summary Results Displays the results of the calculation. 
 

Figure 1  PIPER Start up screen 

The following sections of this chapter contain detailed information on the functions available 
within these tabs. 
 
 

Menu Bar
Toolbar Buttons

Tabs
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2.2. Conditions Tab 
The Conditions tab allows the conditions for the calculation to be entered. 
 

Figure 2  The Conditions Editor 

Usage 
Specify: Specify the ‘Flowrate & inlet pressure’ OR the ‘Inlet & exit pressure’. 
  
Flowrate & inlet 
pressure 

Selecting this means that the calculation takes the following form: 
•  Calculation of the pressure drop at a specified flowrate 
•  Calculation of the maximum non-choked flowrate if the specified 

flowrate is choked. 
Data input selections available are: 
•  Actual flowrate (Kg/s) 
•  Inlet Pressure (N/m2) 
In both cases the results also provide: 
•  Inlet and outlet conditions at the solution flowrate. 
•  Detailed conditions and physical properties for each element in the 

pipe system. 
•  Flow and physical property warning messages. 
Note. PIPER is capable of examining vacuum as well as pressurised 
systems. This means that the outlet conditions are not limited to 
atmospheric pressure. Always check the results when using this 
calculation mode to ensure that the outlet pressure does not go below 1 
atm when examining systems that exhaust into the atmosphere. 

Inlet & exit pressure This is only active when ‘Flowrate & inlet pressure’ is not selected. 
•  Calculation of the flowrate with specified inlet and back pressures. 

If the calculated flowrate is choked, PIPER calculates the 
maximum non-choked flowrate. 

•  All the pressure discontinuities within the system are modelled at 
the maximum non-choked flowrate if the system is choked. 
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Data input selections available are: 
•  Flowrate (estimate 1) Kg/s 
•  Flowrate (estimate 2) Kg/s (this is optional) 
•  Inlet pressure (N/m2) 
•  System Back Pressure (N/m2). 

Inlet Conditions: Specify the ‘Inlet Mass Quality’ OR the ‘Inlet Temperature 
(Temperature or Mass Quality may be supplied for a multi-component 
two-phase flow). 

Inlet Mass Quality Remember the following points when entering data: 
•  Mass Quality must be supplied for a single component two-phase 

flow. 
•  For all cases, a Mass Quality of 0.0 or 1.0 denotes a saturated 

liquid at bubble point or a saturated vapour at dew point 
respectively. 

Inlet Temperature Temperature must be supplied for a subcooled liquid or a superheated 
gas flow. 
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2.3. Physical Properties Tab 
As PIPER works with a rigorous physical properties model, physical property data must be input 
into PIPER by means of a Physical Property (.PPB) data file produced using PhysPack. 
 

Figure 3  Physical Properties Editor 

The .PPB file supplies the following information to PIPER: 
 
•  Chemical components present in a system 
•  Physical properties required by PIPER 
•  Methods selected to calculate the physical properties 
•  Data coefficients for each component and property. 
 
The following properties must be specified in the PPB file for PIPER irrespective of the flow to be 
modelled: 
 
•  Molecular Weight 
•  Critical Pressure 
•  Critical Temperature 
•  Liquid Density 
•  Vapour Density 
•  Liquid Enthalpy 
•  Vapour Enthalpy 
•  Liquid Viscosity 
•  Vapour Viscosity 
•  Ratio of Specific Heats 
•  Vapour Liquid Equilibrium. 

Note. The user must verify the physical property model they have created before running 
PIPER (see Appendix A for more information). 

The physical properties package Properties Plus produced by Aspen Technology Inc. can also be 
used to generate an Aspen Physical Properties Datafile (.APPDF) for use by PIPER. 
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Usage 
Physical Properties File: 

Physical Properties 
File ‘Browse’ 

Mandatory. 
Use the ‘Browse’ button to select the required physical properties 
.PPB or .APPDF file. 

Stream Types Mandatory. 
Select the stream type from the pull down list and enter the 
composition of the inlet stream. 
•  This can be done in terms of mass or molar flowrate, mole 

fraction or mass fraction. 
•  PIPER provides the option to normalise the data if the fractions 

do not add up to 1.00. 
 
Temperature Limits and Flows: 

Temperature Ranges Mandatory. 
The minimum and maximum temperature ranges that are expected 
when modelling the flow through the system. 
•  The user should ensure that the physical property model has been 

verified over this range. 
•  Limits can be extended during the calculation if they prove to be 

inadequate but cannot be extended beyond the range of the 
underlying physical properties file. 

 
Inerts: 

Set Inerts flag Optional. 
Checking this box means that you must enter the threshold level of 
composition below which no warning messages are produced when 
the inerts switch logic is implemented. The inerts switch is used by 
PhysPack to allow calculations to proceed when data is missing or 
out of range for components with low concentrations. Typically this 
is implemented when calculating properties for mixtures that contain 
supercritical components. 
Note. This option is normally left unchecked. 
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2.4. Pipe Editor Tab 
The Pipe Editor tab is used to add the fittings to the pipe. 
 

Figure 4  The Pipe Editor 

Usage 
Pipe Section Editor: 

To Add a section: Select a section from the ‘Type:’ box in the top 
left of the Editor. The appropriate data entry fields 
appear below the box so the relevant details for 
each pipe section can be entered. 

 

To Edit a section: Click on the section in the Section list. The data 
associated with that section is then displayed in 
the data entry fields on the left of the Editor. 

Type Mandatory. 
Select a section type from the following list: 
•  Bend 
•  Contraction 
•  Enlargement 
•  Gate Valve* 
•  Globe Valve (Cast Body)* 
•  Orifice* 
•  Straight. 
* See section 2.4.1 for more information on Orifices and Valves. 
The data entry fields displayed vary depending on which section type 
is selected. Help is available for any field by pressing F1 while that 
field is activated. 
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Usage 
Conduit section 
comment 

Optional. 
Use this field to record any explanatory comments for the selected section. 

Add The Add button (located above the selection list on the right of the screen) 
adds a section to the list on the right-hand side of the Editor. The new 
section is added at the end of the list if the pipe already has sections. 

Ins. The Insert button adds the current section to the section list below the 
item currently highlighted. 

Del. The Delete button removes the section currently highlighted from the 
section list. 

Move The highlighted section can be moved Up or Down the list using the 
arrow buttons. This allows the sections that comprise the pipe to be 
rearranged. 

2.4.1. Additional information on input data required for Orifices and Valves 
Each time an orifice, a globe valve or a gate valve is modelled, the calculation is split into two 
separate parts: 
 
1. A choke test is performed by modelling the flow as a contraction from the upstream pipe area 

to the minimum available area for flow within the fitting. (For an orifice this area is taken to 
be the orifice area). 
 

2. If the flow is not choked, the pressure drop through the fitting is calculated using the K-value 
to represent the frictional loss. 

 
The K-value is not used in the first calculation and the minimum available area for flow is not used 
in the second calculation because these data items are independent as far as PIPER is concerned. 
However, they must be consistent so as to correctly model the fitting (the degree of valve opening 
is used only in the calculation of K-value). 
 
If the minimum available area for flow is equal to the upstream pipe diameter then no initial choke 
test is performed but, as with other section types, a choke may be detected while calculating the 
pressure drop through the fitting. 
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2.5. Summary Results Tab 
The Summary Results tab is activated after a successful calculation.  
 
Options on the ‘Results’ menu can be used to view, print and save detailed results from the 
calculation. 
 
The calculation results displayed after a successful calculation are: 
 
•  Total flowrate or pressure drop 
•  Summary description of the calculation and any warning messages 
•  Graphs of mass quality (two-phase) and static pressure along the pipe 
•  Tables of conditions and physical properties along pipe. 
 

Figure 5  A typical Summary Results dialogue after a successful calculation 

 
The ‘View Tables/View Graphs’ button allows switching between graph and table views. 
 
The level of diagnostic data output from a calculation can be set by the user. See section 2.6.3 for 
more information on Diagnostic Output Levels. 
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2.6. PIPER Menus 
This section lists the various menus and describes the options that are available. 

2.6.1. File Menu 
The File menu allows you to access the following options: 
 
Menu Option Definition 
New Creates a new file. 
Open Allows an .SCD file to be opened via the ‘Open .SCD File’ dialogue box. 
Save Saves the file (PIPER files are saved with a .SCD extension). 
Save As… Saves the file as a new name. 
Print Setup Displays the ‘Print Setup’ dialogue. 

2.6.2. Tools Menu 
The Tools menu allows you to access the following options: 
 
•  Pipe Inner Diameter Calculator 
•  Molecular Weight Calculator 
•  K-value Calculator 
•  Pipe Roughness Calculator 
•  Calculator 
•  Text Editor. 
 
These are detailed in the following sections. 
 
 
 



 
 

 

Page 18 of 46 PIPER User Guide 
Document Version 1.4 – 24 October 2005 

2.6.2.1. Pipe Inner Diameter Calculator 
This dialogue is used to calculate the pipe inner diameter. 
 
Select a standard pipe size then the available schedules for that pipe size. The details for that 
combination are displayed at the bottom of the dialogue box. 
 

Figure 6  Pipe Inner Diameter Calculator dialogue 

The following selections can be made from this dialogue: 

Usage 
Standard Pipe Sizes Lists the pipe sizes available from 1/8″ to 36″. 

Schedules Available Lists the pipe schedules available for the pipe size selected. 

Inner Diameter Displays the Inner Diameter of the selected pipe. 

Wall Thickness Displays the Wall Thickness of the selected pipe. 

Outside Diameter Displays the Outside Diameter of the selected pipe. 

Return Use the radio button to indicate which selection is to be returned to the 
program. The default is Inner Diameter. 

OK Pressing the OK button returns the chosen value to the program. The 
value is pasted into the cell that was highlighted when the Pipe Inner 
Diameter Calculator was selected. 
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2.6.2.2. Molecular Weight Calculator 
This calculates the molecular weight of a compound given its formula. The following rules are 
used to interpret the formula: 
 
•  Elements are given their usual atomic symbol, for example, He for Helium and O for Oxygen. 

The first character must always be upper case and the second (if there is one) lower case. This 
enables the Molecular Weight Calculator to distinguish formulae such as PO and Po. The 
calculator regards the first of these as Phosphorous and Oxygen and the second as the element 
Polonium.  
 

•  No other symbols are recognised, for example, common groups like benzene rings, ethyl 
groups etc. 
 

•  Elements can be followed by numbers and are separated by spaces, dots or colons. 
 

•  Brackets can be used as required to any level. For example, CH3(CH2)10CH3 would be one 
way of describing Dodecane (see Figure 7). However, note that in this example the 10 refers to 
the CH2 group, not the succeeding CH3. Thus water of crystallisation must be specified as 
Na3SO3(H2O)5. 
 

•  The atomic weights used by the Molecular Weight Calculator are taken from Perry’s Chemical 
Engineers Handbook. 

 

Figure 7  Molecular Weight Calculator dialogue 

The following selections can be made from this dialogue: 

Usage 
Enter Chemical Formula Enter the chemical formula then click on the ‘=’ button to 

calculate the molecular weight. 

Mol. Weight Outputs the molecular weight for the formula entered. 
The molecular weight calculated is automatically pasted into the 
cell that currently has focus when the dialogue is closed. If this 
cell does not accept the value it is pasted to the clipboard instead. 

Cancel Pressing the Cancel button pastes the calculated value into the cell 
that was highlighted when the Molecular Weight Calculator was 
selected. 
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2.6.2.3. K-value Calculator 
The Fittings Loss (K-value) calculator consists of a number of tabs where the fitting's details of a 
pipe are built up. The front sheet of the dialogue contains a summary of the following tabs: 
 
•  Tee Junctions 
•  Bends 
•  Valves 
•  Expansions/Contractions 
•  User Defined (Process Equipment) 
•  Manual Adjustment. 
 

Figure 8  Fittings Loss (K-value) Calculator dialogue 

The following selections can be made from this dialogue: 

Usage 
Summary Tab:  
 - Sub Total Outputs the sub total before a manual adjustment is added. 
 - Manual Adjustment The manual adjustment field is for entering miscellaneous fittings. 

It is also used for manually adjusting the model in the validation 
stage or for studying the effect of changes, for example, changing 
a control valve position. 

 - Reason for Adjustment Text describing the reason for adjustment can be entered in this 
field. 

 - Overall Total Outputs the overall total combining the sub total and the manual 
adjustment to produce the fittings loss value for the fitting. 
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The Tee Junctions calculation takes into account any blanked off 
junctions. This can also be a line where the dead leg is isolated at 
a valve further downstream. 

Tee Junctions Tab: 

Add a Tee 
Junction: 

Select a Tee Junction Type, enter the 
Quantity and click on Add. The entry is 
added to the list at the bottom of the sheet. 

 Remove a Tee 
Junction: 

Select the Tee Junction then click on 
Delete. 

 An example of a typical Tee Junction tab display is shown below: 

 
 

Bends Tab: Bends are entered and deleted using the same method as for Tee 
Junctions. 
An example of a typical Bends tab display is shown below: 
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Valves are entered by selecting a valve type then double-clicking 
on it. 
This displays the various categories of valve available for that 
type, for example, the Globe Valve type has two categories – cast 
valves and forged valves (see below). 
Add a Valve: Click on the category required and select a 

valve from the ‘Pipe Size (Nominal Bore)’ 
drop down list. Specify how many of these 
valves are required in the ‘Quantity’ box 
then click on Add. 

Valves Tab: 

Delete a valve: Select the valve from the list and click on 
Delete. 

 An example of a typical Valves tab display is shown below: 

 

Select either the Expansion or Contraction radio button then 
follow the same method as for Tee Junctions. 
For exit losses: Select an expansion with a small/large area 

ratio of zero. 

Contractions/Expansions 
Tab: 

For entry losses: Select a contraction with a small/large area 
ratio of zero. 

 An example of a typical Contractions/Expansions tab display is 
shown below: 
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User Defined (Process 
Equipment) Tab: 

The easiest way to model process equipment (for example, heat 
exchangers and filters) is as a section of pipe with a fitting loss 
coefficient. 
The pipe length needs to be short so that the pressure drop is 
solely due to the fittings − 1m is generally used. 
The values for mass flow, pressure drop etc. can be obtained from 
the process datasheet. 
Static head changes between inlet and outlet should not be taken 
into account as the node information deals with this. 
An example of a typical User Defined (Process Equipment) tab 
display is shown below: 

Note. The K-value is automatically posted into the cell that is currently active when the K-value 
dialogue is closed. This value is pasted to the clipboard if the cell does not accept the 
value. 

2.6.2.4. Pipe Roughness Calculator 
This calculator is used to select a Surface Type and Absolute Roughness. Clicking on OK then 
adds the selection to the calculation by pasting the selected value into the cell that was active when 
the calculator was called. 
 
The units of measurement for roughness depend on the program calling the Pipe Roughness 
Calculator. Those for PIPER are in mm. For other programs (for example, FLONET) the Pipe 
Roughness Calculator displays and returns the relative roughness based on the relevant pipe 
diameter. 
 

Figure 9  Pipe Roughness Calculator dialogue 
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2.6.2.5. Calculator 
Displays the Windows calculator to assist with your calculations. On-line help is also available 
directly from this dialogue. 
 

Figure 10  Calculator dialogue 

2.6.2.6. Text Editor 
Displays the Notepad text editor. 
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2.6.3. Options Menu 
The Options menu allows you to access the following options: 
 
•  Calculation Options 
•  Show Calculation Progress. 

2.6.3.1. Calculation Options 
This allows additional calculation control parameters to be selected when a network is solved. 
 

Figure 11  Calculations Option dialogue 

The following selections can be made from this dialogue: 

Usage 
Convergence 
tolerance 

Mandatory. 
Entering a value in this field adjusts the convergence tolerance. 
Considerable time can be saved by relaxing this tolerance and avoiding 
unnecessary iterations of the program when calculating flowrates 
especially if these are close to choked. 

Mandatory. 
The following levels can be selected: 
Terminal errors 
only 

Displays an output message only if a terminal 
error occurs (this is the default setting). 

All errors Displays an output message if any terminal or 
non-terminal error occurs. 
This also provides a summary of violations of 
temperature and pressure ranges for physical 
properties. 

Physical properties 
diagnostic level 

All errors, with 
details 

Displays an output message if any terminal or 
non-terminal error occurs. 
This also provides a table of temperature and 
pressure ranges for physical properties together 
with details of all violations of the ranges. 
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Usage 
Mandatory. 
The following levels can be selected: 
None No diagnostic information displayed (this is the default 

setting). 
Summary Provides a summary of the calculation through the 

system at each flowrate. 
Detailed Provides a summary of the calculation through the 

system at each flowrate plus the inlet and outlet 
conditions for each section at each flowrate. 

Piper diagnostic level 

Complete 
diagnostics 

Provides a summary of the calculation through the 
system at each flowrate plus the inlet and outlet 
conditions for each section at each flowrate. Details of 
the course of the iterations in each section are shown 
as they proceed. 

2.6.3.2. Show Calculation Progress 
Selecting this option allows detailed output from the calculation to be viewed on-screen while it is 
still running. This slows down the running speed but also provides important information about the 
calculation. 

Note. When selecting this option a window is displayed advising the user that this selection 
slows down the calculation time considerably. 

2.6.4. Calculate Menu 
The Calculate menu allows you to access the following option: 
 
Menu Option Definition 
Calculate To start a PIPER calculation either click on the calculate button (see left) 

or select ‘Calculate’ from the main PIPER menu bar. 

2.6.4.1. Additional information on using the Calculate option 

•  When a PIPER calculation is started, the data entered is passed to the calculation module. This 
module runs separately from PIPER itself but the program informs the user that it is 
calculating. A 'Stop' button allows the calculation to be terminated as a complex and lengthy 
calculation (such as calculating the maximum non-choked flow) can take a significant amount 
of time. 
 

•  PIPER can be minimised during lengthy calculations such as a large piping system or when a 
high diagnostic output is specified. However, the PIPER calculation module is processor 
intensive and, even when it is minimised, other applications may run more slowly during the 
calculation. 
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2.6.5. Results Menu 
The Results menu allows you to access the following options: 
 
Menu Option Definition 
View Detailed Results Displayed the detailed results on the screen (see section 3.2.7). 
Print Detailed Results Prints the detailed results on the default printer (see section 3.2.8). 
Save Detailed Results Allow the calculation results to be saved as an .OUT file (see 

section 3.2.10). 

2.6.6. Help Menu 
The Help menu allows access to the on-line help facility available with PIPER and the latest 
version information. 
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2.7. The PIPER Toolbar 
The buttons on the toolbar allow the following options to be selected: 
 

Button   Purpose 

 

Create new PIPER file 
Creates a new PIPER file. 

 Equivalent File menu item − New 

 

Open a PIPER file 
Opens an existing (saved) PIPER file. 

 Equivalent File menu item − Open 

 

Save PIPER file 
Saves the PIPER file currently open. 

 Equivalent File menu item − Save 

 

Calculate current problem 
Solves the current network and displays the results in the Summary Results dialogue. 

 Equivalent Calculate menu item − Calculate 

 

Print summary of calculation results 
Prints out the screen results including: 
•  Results Report 
•  Physical Properties Report 
•  On-screen graphs. 

 Equivalent menu item − N/A 

Table 1  The PIPER Toolbar 
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3. PIPER Tutorial 

3.1. General 
This example details the procedure to calculate pressure drops and flowrates for a two-phase 
mixture (water and ethanol) in an unbranched pipe (see Figure 12). 
 

Figure 12  PIPER - Calculation example 

3.2. Solving the Network 
The procedure to solve the network involves the following steps: 
 
•  Defining the physical properties using the PhysPack program 
•  Accessing PIPER 
•  Entering Conditions data 
•  Entering the Physical Properties data defined in PhysPack 
•  Entering Pipe data 
•  Solving the Network. 
 
The results can be viewed, printed and saved after the network has been solved. 

3.2.1. Defining a Physical Properties file 
Use the PhysPack program to define a physical properties .PPB file for water and ethanol (see 
Appendix A for the procedure). 

3.2.2. Accessing PIPER 

Procedure 
1. Access PIPER by selecting Start | Programs |PEL | then click on the PIPER icon (see left). 

 
2. A splash screen showing the program name and version number appears briefly before the start 

up screen (see Figure 1) is displayed. 

Water/Ethanol
(0.5/0.5)

3 bara

100 °C

10 m, 3" Schedule 40, Roughness 0.05 mm

Loss Coefficient 2.0

Atmosphere
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3.2.3. Entering Conditions data 

Procedure 
1. Select the ‘Inlet & exit pressure’ button on the ‘Conditions’ tab. 

 
2. Click on the ‘Flowrate (estimate 1)’ box and enter the value 20.  

 
3. Click on the ‘Inlet Pressure’ box and enter the value 3 bara. (PIPER automatically converts the 

units - see Appendix B for more information). 
 

4. Click on the ‘System Back Pressure’ box and enter the value 1 atm. 
 

5. Click on the ‘Inlet Temperature’ box and enter the value 100 C. 

3.2.4. Entering Physical Properties data 

Procedure 
1. Select the ‘Physical Properties’ tab. 

 
2. Click on the ‘Browse …’ button and select the .PPB physical properties file defined in 

PhysPack (see section 3.2.1 for more information and Appendix A for the procedure to 
produce the .PPB file). 
 

3. Information from the .PPB file is loaded into PIPER and displayed in table form including a 
list of components (see Figure 13). 
 

Figure 13  Physical Properties Editor showing .PPB file data 

4. Click on the ‘Mass Fraction’ field and change the values for ethanol and water to 0.5. The 
‘Totals (AVMW)’ box below now displays 1. 

Note. PIPER normalises the value to 1 if they do not add up. 

5. Go to the ‘Temperature Limits and Flows’ panel and click on the Temperature Ranges 
‘Min.’ box. Enter the value 300. 
 

6. Click on the ‘Max.’ box and enter the value 500. 
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3.2.5. Defining the Pipe fittings using the Pipe Editor 
The vessel outlet is represented as a contraction from a nominally large diameter such as 1 m to 
the pipe diameter. 

Procedure 
1. Select the ‘Pipe Editor’ tab. 

 
2. Click on the ▼ arrow next to the ‘Type’ box and select Contraction from the list. 

 
3. Click on the ‘Upstream pipe diameter’ box and enter the value 1. 

 
4. Click on the ‘Downstream pipe diameter’ box. Go to the ‘Tools’ menu and select the ‘Pipe 

Inner Diameter Calculator’. 
 

5. Select a ‘3″ Schedule 40’ pipe and click on OK. PIPER pastes the internal diameter into the 
‘Downstream pipe diameter’ box. 

 
6. Click on the ‘Upstream pipe roughness’ box. Go to the ‘Tools’ menu and select the Pipe 

Roughness Calculator. 
 

7. Select ‘Mild Steel (slightly corroded)’ and click on OK. PIPER pastes the value into the 
‘Upstream pipe roughness’ box. 

 
8. Repeat steps 6 and 7 for the ‘Downstream pipe roughness’ box. 

 
9. Click on the Add button. The text ‘Contraction’ is added to the right-hand box. 

 
10. The Pipe Editor now looks like this: 

 

Figure 14  Pipe Editor showing Contraction values 

Adding the Bursting Disc 
The Bursting Disc is modelled using an orifice with an approximate loss coefficient to represent 
the fitting. 

 
11. Click on the ▼ arrow next to the ‘Type’ box and select Orifice from the list. Notice that 

PIPER has inserted the current pipe diameter for the upstream pipe and orifice diameters. 
 

12. Click on the ‘Orifice diameter’ box and enter the value 0.07 (this represents 90% of the orifice 
diameter). 

 
13. Click on the ‘K-value for orifice’ box and enter the value 2.0. 
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14. Click on the Add button. The text ‘Orifice’ is added below ‘Contraction’ in the right-hand 
box. 

 
15. The Pipe Editor now looks like this: 
 

Figure 15  Pipe Editor showing Orifice values 

Adding the Straight 
The 10 meter straight pipe is now added to the model. 
 
16. Click on the ▼ arrow next to the ‘Type’ box and select Straight from the list. Notice that 

PIPER has again inserted the current pipe diameter and roughness as default values. 
 

17. Click on the ‘Pipe length’ box and enter 10. 
 

18. Click on the Add button. The text ‘Straight’ is added to the list below ‘Orifice’ in the right-
hand box. 

Adding the Enlargement 
An enlargement is now added to model the pipe exit to the atmosphere. This is modelled by an 
expansion to a nominally large diameter such as 1 m. 
 
19. Click on the ▼ arrow next to the ‘Type’ box and select Enlargement from the list. Notice that 

PIPER has inserted suitable default values to the ‘Upstream/Downstream pipe diameter’ and 
‘Upstream/Downstream pipe roughness’ boxes. 

 
20. Click on the Add button. The text ‘Enlargement’ is added to the list in the right-hand box. 

 
21. The Pipe Editor now looks like this: 

 

Figure 16  Pipe Editor showing final values 
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3.2.6. Calculating the Network Solution 

Procedure 
1. Click on the Calculate button (see left) on the PIPER toolbar or select the Calculate menu 

option. 
 

2. A message ‘Calculating – Please wait’ is displayed. 
 

3. After a few seconds the ‘Summary Results’ tab is activated and displays the results of the 
calculation as shown in Figure 17: 
 

Figure 17  Summary Results dialogue 

3.2.7. Viewing Detailed Results 
Selecting the ‘View Detailed Results’ menu option from the ‘Results’ menu displays the results on 
a NotePad screen. 

3.2.8. Printing Results 
Results can be printed using the following methods: 

3.2.8.1. Print Detailed Results menu option 
Selecting the ‘Print Detailed Results’ menu option from the ‘Results’ menu prints the contents of 
the NotePad screen viewed in section 3.2.7 showing the results of the problem that has just been 
run. 
 
The report contains detailed information under the following headings: 
 
•  Details of Conduit System 
•  Details of Input Stream 
•  Summary of Calculation 
•  Details of Output Stream 
•  Conditions of the end of each conduit 
•  Physical Properties at the end of each conduit 
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•  Violations of temperature and pressure ranges for physical properties. 

Note. The printer should be set to ‘Landscape’ page mode when printing this report. 
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3.2.8.2. Print Summary of Calculation Results 
This button (see left) prints the results data in the form of: 
 
•  Results Report 
•  Physical Properties Report 
•  Graphs. 
 
The following show examples of these: 
 
 
  Results 

 

Pipe 
Section 

Section 
Type 

K value or
Length 

m 

Static 
Pressure

N/m2 

Pressure 
Drop 
N/m2 

Temperature 
K 

Mass 
Quality 

Homogenous 
Velocity 

m/s 

Pressure 
Discontinuity 

0 Feed - 300000 0 373.15 0 0.038914 - 
1 Contraction .58613 CC 274015 25984.8 373.144 0 6.40762 - 
2 Orifice 2.00000 KV 240431 33584.4 373.144 0 6.40762 - 
3 Straight 10 201679 38751.4 373.144 0 6.40762 - 
4 Expansion 0 101325 100354 355.44 0.055058 1.5288 Yes 

Figure 18  Results Report 
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     Physical Properties 
 

Pipe 
Section 

Section 
Type 

Straight 
Pipe Void 
Fraction 

Liquid 
Mol Wt 

Vapour
Mol Wt 

Liquid 
Density
kg/m3 

Vapour
Density
kg/m3 

Liquid 
Viscosity
N.s/m2 

Vapour 
Viscosity
N.s/m2 

Liquid 
Enthalpy 

J/kg 

Vapour 
Enthalpy

J/kg 

Fail 
Flag 

0 Feed 0 25.9014 1 817.977 0 0.000294 0 -1404947 0  
1 Contraction 0 25.9014 1 817.983 0 0.000294 0 -1404968 0  
2 Orifice 0 25.9014 1 817.983 0 0.000294 0 -1404968 0  
3 Straight 0 25.9014 1 817.983 0 0.000294 0 -1404968 0  
4 Expansion 0.58971 25.5563 33.7157 837.961 1.17392 0.000365 1.1E-005 -14091718 84243.8  

Figure 19  Physical Properties Report 
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3.2.9. On-screen Graphs 
On-screen graphs are produced in the following format: 
 

Figure 20  Results Graphs 

3.2.10. Saving Detailed Results 

Procedure 
1. Click on the ‘Save Detailed Results’ menu option from the ‘Results’ menu. The ‘Save Results 

File As’ dialogue is displayed. 
 

2. This saves the results as a *.out text file. This can then be edited using any text editor or Lotus 
1.2.3. 

 

Figure 21  Save Results dialogue 

 
 
 
 



 
 

 

Page 38 of 46 PIPER User Guide 
Document Version 1.3 – 10 October 2002 
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Appendices 

Appendix A – Creating a .PPB file 
The following text is adapted from the 60 Second Guide to Physical Property Files. 

Procedure 
1. Click on Start | Programs | PEL | PhysPack. The main PhysPack window appears. 

 
2. There are two tabs – one for Data Selection and one for Calculation. The one for Data 

Selection is selected by default. The Data Selection tab has two panels. The one on the left is 
a tree view that resembles Microsoft Explorer. Under Process, there are two branches – 
Components and Properties. 
 
The first thing we need to do is add the components. 
 

3. Click on Components in the tree view. The right hand panel changes to the Components tab. 
In the Search for Name box, type ETHA for ethanol. All the components on the databank 
beginning with ETHA are then listed below. Double-click on Ethanol to add it to the tree. 
Next, type W for water and double click. 
 
Next, we need to add the properties that PIPER requires. 
 

4. Click on the box near the top of the screen containing the text select a program to select the 
required properties. 
 

5. Select PIPER – Low Pressure from the pull-down list. PhysPack will automatically add the 
properties that PIPER requires to the Properties in the tree view. 
 
PhysPack will have chosen a default method to calculate each property. Let’s see which ones 
it has selected. 
 

6. Click on the property Vapour Liquid Equilibrium in the tree view. The right hand panel 
changes to the Methods panel. You can see that the IDEAL method has been selected. 
 
But is this sensible for a mixture of ethanol and water? Let’s ask the PhysPack Advisor. 
 

7. Click on the Method Advice Wizard button on the toolbar. The wizard will then appear. 
When you’ve read the introduction, click Next . The two key components are set to ethanol 
and water. Click Next again and set the system pressure to Low. Click Next again and you 
will see that all the binary interaction parameters are present to model the liquid phase by 
either the WILSON E and UNIQUAC methods. Follow the advice and select WILSON E. 
When you click Next, you will see that the Advisor suggests IDEAL for the vapour phase and 
WILSON E for the liquid. Follow his advice and let him make the changes by clicking Finish 
and then Yes to Add Methods?  
 
That’s it for Vapour Liquid Equilibrium. Now let’s check the methods for the other properties. 
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8. Click on each of the other properties in turn. As you do so, look in the Method panel on the right 
and check that All Data is present in the Data Status column for the selected method. Note that for 
the properties VAPOUR DENSITY and RATIO OF SPECIFIC HEATS Miss Binary is reported. 
Binary interaction parameters are desirable for these properties but RKS will give a reasonable 
approximation without them so it’s okay if they are missing. 
 
That’s all there is to preparing the PPB file but before we save it it’s a good idea to do some 
calculations to check everything is okay. 
 

9. Click on the Calculation tab near the top left hand side of the screen. Two new panels appear – the 
one on the left is a vertical menu and the one on the right is the input screen for the selected menu 
item. 
 
The first thing to do is to select a Mixture (Standard) type of calculation 
 

10. Click on Conditions on the left, then in the right hand panel click on the down arrow in the 
Calculation Type box and select Mixture (Standard). 
 
Next we need to set the feeds for each component – 50% ethanol, 50% water by mass fraction 
 

11. Click on Feed on the left, then in the right hand panel click on the spreadsheet twice – once to give 
it focus and again to select the mass fraction column. Type 0.5 for ethanol, 0.5 for water. 
 
Now we’re ready to do the calculation and see the results so … 
 

12. Click on Calculate on the left. After a few seconds PhysPack presents the results in a spreadsheet 
on the right. 
 
Note that the values in the Stream Vapour Fraction columns are in blue. This is because the 
temperatures and pressures are below the accuracy limits for the WILSON E binary interaction 
parameters. This is not important for this example. 
 
So now we are ready to export the PPB file. 
 

13. Click on the File menu and select Export. The Export a PPB File window appears. Select the C 
drive and save it as PIPER.PPB 
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Appendix B – In-cell Units Conversion 
Units conversion is available for any field where it is appropriate. The conversion is always from 
the units entered to the units shown on the dialogueue box. 
 
In order to perform a units conversion you should type the following information into a field: 
 

Value_Unit 
 
where: 
 
Value is the figure to be converted 
Unit is the unit to be converted 
‘_’ is a space. 
 
The units conversion (if it is possible) is performed automatically as soon the cursor is moved 
from the current field, as shown below: 

Example 

1. Enter the value and unit 2 ″″″″ (inches). 
 

 
2. Move the cursor off the field or press Enter. The field now displays the following: 

 

 
3. If the conversion is not possible a message box is displayed and the value in the field is taken 

as being in the units specified on the dialogue box. 
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Appendix C – Choosing a Fluid Flow Program 
Eutech PEL contains four programs which are capable of fluid flow calculations. These are: 
 
•  PEW 
•  ADRIAN 
•  FLONET 
•  PIPER 
 
The capabilities of each of these programs are summarised below and in Figure 22: 

PEW 
This program can handle: 
 
•  A single, unbranched pipe of a fixed diameter. 
•  Incompressible and compressible flow calculations. Compressible flow calculations are valid 

up to approximately 0.3 Ma and include isothermal and adiabatic modes. 
•  Single phase gas or liquid. 
•  Design calculation as well as rating calculations, that is, for a fixed flow and required pressure 

drop it will calculate the pipe diameter. 

ADRIAN 
This program can handle: 
 
•  Rating calculations in branched networks of high velocity gas flows. 
•  Single phase gas flows up to 1.0 Ma including modelling of choked systems. 
•  Isothermal and adiabatic calculations. 
•  Directed piping network (that is, the fluid flow from the beginning of the pipe to the end of the 

pipe) allowing for changes in diameter and full consideration of the order in which fittings 
occur. 

•  Loop-like as well as tree-like networks with care. 

Note. ADRIAN is only valid for fully turbulent flow regimes. 

FLONET 
This program can handle: 
 
•  Rating calculations in complex networks of single phase gas or liquids. 
•  Isothermal calculations only and gas flow below 0.2 Ma. 
•  Complex networks can be modelled including loop-like structures with unknown direction. 
•  Turbulent, transitional and laminar flow regimes. 
•  Pumps and None-Return Valves can be included in the network. 

PIPER 
This program can handle: 
 
•  Single phase gas or liquid and two phase flow. 
•  Single unbranched pipe of variable diameter. 
•  Very detailed physical properties representation allowing modelling of phase change 

throughout the piping system and modelling of non ideal gases. 
•  Allows for heat transfer through the pipe wall. 
•  Fully models all pressure discontinuities and calculate maximum non-choked flow in a system. 
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Figure 22  Choosing a Fluid Flow Program 

PEW

Design Calculations

Which Fluid Flow
Program?

PIPER FLONET ADRIAN

Rating Calculations

Two Phase Liquid Gas

Non Ideal Near Ideal

Low
Ma < 0.2

High
Ma > 0.2
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Appendix D – Troubleshooting 
Refer to the following points if you are experiencing problems when running PIPER. 
 
•  PIPER does not contain a large list of different fitting types. This can be overcome by using an 

orifice model with an appropriate loss co-efficient to represent missing fittings. 
 
•  Inlets from a vessel can be modelled by a contraction from an arbitrarily large inlet diameter 

(suggested size of 1 m) down to the inlet pipe diameter. 
 
•  Similarly, outlets to atmosphere can be modelled by an expansion from the outlet pipe 

diameter up to an arbitrarily large diameter (suggested size of 1 m). 
 
•  Incorrect answers are most commonly caused by poor physical properties representation or by 

incorrectly specified pipe systems. Always check the .PPB file in PhysPack (or similar 
program) over the range of conditions present within the piping system to ensure that it gives 
an accurate representation of the fluid in the system. 

 
•  Remember that PIPER requires input in strict SI units. Use the in-cell units conversion feature 

(see Appendix B for more information) to enter inputs in normal engineering units. 
 
•  Be aware of ‘non-fatal’ errors where the program appears to produce results without a problem 

but these results not match your system. Causes could be: 
 

On the Input side: These include cases where the piping system has been 
inadequately described, that is, failure to specify a pipe 
length for a straight section or a correct bend radius for a 
bend. 

  
On the Output side: These include cases where the solution involves an exit 

pressure less than atmospheric when the system actually does 
exhaust into the atmosphere. 

 

Note. The system will always choke if you try to specify a system that involves full vacuum. 
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Notes 
Use these pages to record any notes. 
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Notes 
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